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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site. You can store your issues of 
MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from Mavericks) to have it appear on your iPhone and iPad (inside iBooks) 
next time you sync. Or print it out, even – and please feel free to pass MagBytes on. 
MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by Mac NZ for this purpose 
only. Find out more about the MagBytes Apple newsletter online (click on Mac NZ MagBytes Newsletter at top centre).

February 2016  
•2——Mac News ~ 

Telecommuting, big data, 
eBooks settlement, 4th in 

laptops, Office, USB-C recall, 
super dock, Bafta. 

•4——Updates ~ iOS 9.2.1, iOS 
date bug, Samsung dumped, 
OS10.11.4 Beta, Firefox 2 for 

iOS, Apple TV, OS Betas 
 •5——Mac Help ~ Around New 

Zealand 
•6—— iOS & iDevice news 

~ Apple Pay China, Press-on 
games, secret chips, food 

photos, Olloclip, Music, Sonos, 
Eli Lilly iPads 

•8——Tips & Tricks ~ Safari 
on Mac and cursor, iPhone tips, 

more for Safari on Mac. 
•14——Shiny & New ~ 

Commander One, Urban Armor 
Gear iPhone faceplate and 

iPhone 6/6s case

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

Apple and the FBI and us
Apple has published an open letter detailing questions and answers related to its very public stance 
in its fight to avoid creating a hackable version of the iPhone operating system for the FBI. The short 
version is that by creating a hackable iOS, Apple would be setting a very dangerous precedent. Tim 
Cook maintains ‘Let’s talk about privacy, not strip it away.’  
You can read the full text online.
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Mac News Telecommuter ~ Crystalline data ~ court upholds eBooks settlement

Apple the good telecommuter
Apple, Dell, IBM, Aetna, ADP, and UnitedHealth 
Group are among the top companies posting the 
most jobs that allow people to telecommute 
full-time, according to FlexJobs, an online service 
for professionals seeking telecommuting, flexible 
schedule, part-time, and freelance jobs.

‘Superman 
Crystal’ 
storage 
A type of 
crystalline 
storage with 
an estimated 

lifespan of billions of years has been tested with 
documents encoded using the technology. 
That all works out to a theoretical data capacity of ... 
a staggering 360 terabytes.

Federal court upholds $450 settlement
A federal appeals court has upheld Apple’ $450 
million settlement of claims that it harmed 
consumers by conspiring with five publishers to raise 
e-book prices, reports Reuters. 
The Second US Circuit Court of Appeals in New 
York rejected a challenge by an eBooks purchaser to 
the fairness, reasonableness and adequacy of the 
settlement, which won approval from US District Judge 
Denise Cote in November 2014. 61 Hurstmere Road, Takapuna 09 486 1493

Authorised to service iPod, 
iPad and Mac

www.istorenz.com

Enhancing Your Apple Experience

Scan QR Code to quickly 
get in touch with iStore
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Mac News 4th in laptops ~ Microsoft Office ~ USB-C recall ~ Dock ~ Bafta ! 

Apple now fourth in laptops 
Global notebook/laptop shipments 
dropped ‘significantly’ in 2015 mainly due 
to the impact of currency depreciation on 
the demand in Europe and the emerging 
markets, such as Latin America, according 
to TrendForce. However, Apple managed 
to overtake ASUS and Acer to become 
the Number Four brand in the annual 
ranking, says the research group.

Microsoft ‘evaluating options’
Apple consultants and IT specialists 
have had one great way to show their 
clients they have the smarts to support 
Microsoft Office for Mac and iOS – an 
accreditation class and accreditation for 
anyone who took a half day of training and 
evaluation and then passed an exam. This 
year’s schedule doesn’t show that the 
accreditation program will be part of the 
events in 2016. 

‘Limited’ recall of  USB-C
Apple has issued a recall on what it says 
is a “limited number” of USB-C Charge 
Cables that shipped with MacBooks. The 
company said that some of those cables 
can fail due to a design issue, and this 
could result in your MacBook failing to 
charge properly.

Echo 15+ Thunderbolt 2 Dock
If you’re a Mac user needing (or wanting) 
extreme flexibility when it comes to 
connecting accessories and peripherals, 
perhaps give Sonnet Technologies’ Echo 
15+ Thunderbolt 2 Dock a serious look. 
With prices starting at US$470, it’s not 
a casual buy, but this 16-port docking 
station for computers with Thunderbolt 
ports is worth the money. 
[This should be available in New Zealand 
via MacSense.]

Kate 
Winslet 
Jobs 
BAFTA
It’s 
beginning 
to look 

as if actress Kate 
Winslet may go for 
the hat trick after 
winning her second 
major award for her 
role as Apple/NeXT 
marketing executive 
Joanna Hoffman in 
the movie Steve Jobs. 
In England, Winslet 
snagged the Best 
Supporting Actress 
BAFTA, her second 
win after grabbing 
a Golden Globe for 
the same role on 
January 10, 2016.

Hub Kickstarter
ExoHub will work 
seamlessly with your 
iMac to make your 
workspace more 
functional without 
compromising style. 
The ExoHub has four 
USB 3 ports, 1 rapid 
charger and an SDXC 
card slot.
The company is 
trying to raise funds 
for it on Kickstarter.
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Apple updates iOS 9.2.1 to deal with ‘Error 53’
Apple has rolled out an updated version of iOS 9.2.1 that allows 
users whose iPhones were bricked by ‘Error 53’ to revitalise 
their iDevices. It caused phones whose home buttons had been 
replaced by third-party repair shops to fail a security validation.
“We apologize for any inconvenience, this was designed to be a 
factory test and was not intended to affect customers,” Apple 
told TechCrunch. 
“Customers who paid for an out-of-warranty replacement of 
their device based on this issue should contact AppleCare about a 
reimbursement.”

iOS date bug will freeze your device at startup 
I can’t think of a practical reason for setting the date of your 
iPhone or iPad to January 1, 1970. 
But if you manage to find a reason, don’t do it. You’ll end up with 
an unusable device.

Apple dumps Samsung for TSMC
Apple is distancing itself more from Samsung 
by partnering with Taiwan Semiconductor 
Manufacturing Company (TSMC) to be the sole 
manufacturer of future iPhone processors. 
The deal cuts Samsung out of some serious 
revenue considering how popular Apple’s smartphone is, and is 
already boosting TSMC’s value. Unfortunately, shortly after this 
announcement, an earthquake in Taiwan impacted on the plant’s 
chip production. 

Third OS X 10.11.4 beta fixes Twitter bug
Members of Apple’s public beta program now have access to the 

third preview builds of both OS X El Capitan 10.11.4 for Mac and 
iOS 9.3 for iPhone and iPad.
The third OS X 10.11.4 beta solves issues Safari would encounter 
trying to load shortened Twitter links, according to a developer in 
contact with Apple.

Firefox 2.0 for iOS has convenient new features
A new version of Firefox for iOS is out with some nice additions if 
you’re running a newer Apple iOS device.

Apple adds voice dictation to latest Apple TV
The latest release of tvOS 9.2 beta 3 further addresses the 
device’s text input shortcomings, giving users the ability to enter 
words using voice, rather than the onscreen keyboard.
Incoming! 

More channels to universal search and Siri search
Apple has added Watch ABC, the Disney Channel, Disney Junior 

and Disney XD to the fourth 
generation Apple TV’s universal 
search and Siri search.

The OS Beta beat
Apple has been releasing developer betas of OS X El Capitan, 
watchOS, tvOS, and iOS on Mondays about two weeks apart and 
then following up two days later with public betas. Today brought 
watchOS 2.2, tvOS 9.2, and iOS 9.3 (and beta 4 of OS X El Capitan 
10.11.4) to registered developers.
That means that, following the pattern, the public beta versions 
were expected to appear ... about the time you get this latest 
version of MagBytes.

Updates iOS 9.2.1, iOS date bug, Samsung for TSMC, Firefox 2, Apple TV, OS Betas
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Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Plus there’s Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. 
Every new Mac has a one-year warranty 
and 90 days free phone support. 
AppleCare extends this all out to three 
years. Under NZ law, you are covered by 
the Consumer Guarantees Act against 
anything going wrong that comes 
down to parts failure within reasonable 
expectations (say, inside three years’ use), 
but be prepared to spend anxious time on 
the phone, sticking to your guns to get it 
fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 

If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.

Eden Roskill — This Auckland branch has 
an Apple interest group. 

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 

Mac & iDevice training in Grey 
Lynn, Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ – but I also run the Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. A new 
series is starting Wednesday March 4th at 
7:30pm. Please email if you are interested 
in attending, as I only book a room when I 
can guarantee five attendees. The sessions 
are friendly, open to questions at all times 
and are backed up by handouts, and one 
is running now on Wednesday nights 
(7:30pm). I train (one-to-one at your home 
or workplace (in Auckland) for $95/hour. I 
also present to institutions.
Please email Mark for more info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help Apple assistance, Consumer Guarantees Act, help, support

rest homes. This is a large, well-run and 
successful group.
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iDevice news
Apple Pay in China
Now that Apple Pay has launched in 
China, the mobile payment service 
apparently has the problem of being 
too popular. iPhone users trying 
to sign up for the service ran into 
problems the first day it was available, 
according to a Caixin report.

Press harder, play better
We all did plenty of peeking and 
popping and bringing our Live Photos 
to life when the iPhone 6s and iPhone 
6s Plus were first released, but there’s 
one thing we couldn’t do: play a 
bunch of truly worthwhile, 3D Touch-
enhanced games. But now there’s 
a hearty handful of great iPhone 6s 
games that support 3D Touch in this 
Macworld slideshow: 10 great iPhone 
games with 3D Touch controls.

Apple’s secretive chip dev 
The engineering team responsible 
for the custom silicon that powers 
hundreds of millions of Apple’s iOS 
devices is the latest beneficiary of 
the company’s relatively newfound 
openness.

Bon Appetit  shot on iPhone 
Showcasing the power of the most 

Apple Pay China ~ Press games ~ secret chips ~ food coup
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iDevice newsOlloclip ~ Apple Music ~ Sonos ~ 40% ~ Eli Lilly buys 15k iPads

popular camera in the world, professional photographers for 
Bon Appetit shot the food magazine’s latest issue entirely with 
Apple’s iPhone, with the publication calling it “the hippest 
pocket camera around.”

Olloclip Studio iPhone Case holds lenses
Olloclip has announced that Studio has shipped. Unveiled at 
CES, Studio is a case for iPhone 6/6s and iPhone 6/6s Plus with 
rail-mounted, interchangeable accessories. Those accessories 
include a finger grip, a stand, mounts for Olloclip lenses, mounts 
for tripods and grips, and cold shoe adapters. 
The Studio Case comes with several basic accessories at US$89.99. 
The company also released a behind-the-scenes video about 

Studio that gives you a good idea of all the things it can do.

Apple Music passes 11M subscribers
During a wide-ranging interview published on Friday, Apple 
executives Eddy Cue and Craig Federighi revealed fresh statistics 
on the company’s various internet services like Apple Music, 
which now boasts more than 11 million paying subscribers.

Apple Music and Sonos
 In conjunction with Apple Music’s introduction to the Sonos 
connected speaker platform, the two companies teamed up to 
create a comprehensive ad campaign highlighting the scientific 
benefits of listening to music out loud.

iPhones at 40% of  the US smartphone market
Parks Associates has released new mobile research showing that 
86% of US broadband households now own a smartphone. 
In that research, the iPhone accounted for 40% of the US 
smartphone market in 2015.

Eli Lilly and Company buys 15,000 iPads
Eli Lilly and Company is participating in a ‘secretive program‘ 
with tech giant Apple to make the iPad more business-friendly 
and has bought 15,000 tablets for its workers, according to USA 
Today.
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tips&tricks
1/ Quick address changes — If you’re 
looking at one site and you wish to visit 
another, you don’t have to click within 
the address bar, highlight it and then 
delete the existing address. Hold down 
the Command key, and while it’s held 
down, press the L key and  it highlights the 
current address. Immediately enter the 
new one.
It’s also unnecessary to enter 
‘http:// _ _ _ ; or ‘www’. Simply enter the 
domain, such as mac-nz.com, and then 
press Return to go to that site.
(If you want to always see the full address, 
choose Safari > Preferences> Advanced 
and then turn on Show full website 
address, as Safari no longer shows this by 
default).

2/ No squinting necessary — If the web 
page content is too small to read, you 
don’t have to squint; you can enlarge it 
by pressing and holding Command and 
then tapping the + key on your keyboard 
(Command – [minus or dash] reduced size).
To enlarge the text but not the images, 
choose View > Zoom Text Only.
To specify a minimum font size for Safari 
to use, choose Safari > Preferences > 
Advanced and enter a larger size in the 
Never use font sizes smaller than field (it’s 
visible in the screenshot above). 

Anything over 14 will be eminently 
readable.

3/ Using Reader View — Ads are necessary 
to the monetary health of many websites, 
but they can make it difficult to focus 
on reading — especially when they blink 
or talk back to you. Happily, you can 
eliminate all that by clicking the icon at 
the far left of the address bar (it looks like 
four tiny lines). Then Safari enters Reader 
View.

4/ Share web pages easily — To share a 
page with somebody else, choose File > 
Share > Email This Page and Safari opens 
a fresh email, puts the headline into 
the subject field and inserts a link to the 
page in the message body. (Safari helps 
you send additional web pages to recent 
recipients by adding their 
names to the bottom of the 
Share menu.)
In the email message, use the 
Send Web Content As menu to 
choose between sending a link, 
the whole webpage, a PDF, or 
the webpage in Reader View. 
(The last three options keep 
your recipient from having to 
click the link to see the content.) 
Reader View sends a distraction-

free webpage to your recipient. (These tips 
came from Lesa Snyder at Macworld. 
There are a couple more related tips on 
the page.)

5/ Keep losing your cursor? No more — 
The current display trend is towards much 
higher resolutions: 4K and 5K displays. 
At these native resolutions , everything 
is crisp, clear and .. tiny. It’s all too easy 
to occasionally lose track of the cursor 
whether or not you have El Capitan’s 
‘Shake Mouse Pointer to locate’ enabled. 
(It’s found in System Preferences > 
Accessibility > Display, shown below.)
By making the cursor just a bit bigger to 
begin with, one doesn’t have to engage 
quite as often with that (delayed) 
magnified cursor.

Safari on Mac, and keeping your cursor in sight

mailto:mac.nz%40me.com?subject=From%20MagBytes
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They’re in pockets and bags everywhere: some iPhone tipstips&tricks

1/ Change your iPhone’s video 
capabilities — Apple’s default is the 
“1080p HD at 30 fps” choice. Go to 
Settings> Photos & Camera>Record Video. 
There’s a handy approximation (in yellow) 
for how much space you’ll be taking up 
with each configuration. So if you only 
have a 16GB iPhone, it’s probably not that 
wise to record only 4K video unless you 
plan on clearing off your Camera Roll 
approximately every day of your life. If you 
select any of the other options, your device 
will helpfully inform you of that whenever 
you’re taking videos from then on.

2/ Stop your screen rotating 
— Does your phone switch 
orientations on you at random, 
just because you tilted it slightly 
too far in one direction or 
another?  To prevent this sort of 
annoyance (in my case, reading 
in bed is the best time to lock 
screen rotation). Luckily iOS has 
screen rotation lock: wake your 
iPhone if it isn’t already, then 
slide your finger up from the 
bottom edge to bring up Control Center. 
Tap the Orientation Lock button (the lock 
icon with a circular arrow surrounding it 
at top right) so it turns white. Slide the 
Control Center pane down again to hide it, 
and your screen’s contents will no longer 
rotate as you turn your device on its side.

3/ Lock rotation on iPad — The rotation 
lock works pretty much the same on the 
iPad, but with an added caveat: you can 
switch the Mute button toggle on the 
left side of the device to function as the 
orientation lock switch instead. Go to the 
Settings app, tap General, then tap Lock 
Rotation under the “Use side switch to:” 
heading. When you switch the side toggle 
to function as the rotation lock, the Mute 
function takes the rotation lock’s place in 
Control Center.

4/ Remember that Siri is more intelligent 
— You can now say things like  you can ask 
things like “Remind me to take my coffee 
off my roof when I get in the car,” because 
Siri knows when you get into your car. 
It’s almost like actually having a human 
helper. (Moreover, thanks to the new 
frugal M9 co-processor, you can call Siri 
from a locked screen even on the iPhone 6s 
and 6s Plus.)

5/ iOS 9 on iPhone 6s and 6s Plus — If you 
have the latest version of Apple’s iPhone, 
remember that pressing harder on apps 
gives all sorts of other capabilities, and it 
can do Live Photos (which animate for a 
few seconds) but they take up lots more 
space. If you have an ‘s’ version of the 6, 
check out Mac Observer’s catchup page 
to remember all its new tricks. If you’re on the default setting, though, 

you won’t see any info in that (arrowed) spot

mailto:mac.nz%40me.com?subject=From%20MagBytes
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tips&tricks Alarm! Background App Refresh and more for iDevice

1/  Sleeping through your iPhone’s 
alarm? Sometimes the alarm tone is so 
quiet you can sleep right through it even 
if your iPhone’s speaker was cranked 
pretty high, but maybe you forgot that 
earlier , you turned the 
volume down before 
playing some podcasts. 
When you pressed the 
“volume down” button 
on your iPhone (or 
iPad), it turns down the 
volume for everything, 
including alert tones.
So open Settings, 
choose Sounds and 
scroll down to the 
Ringers and Alerts heading. See the 
Change with Buttons setting? Toggle it 
to ‘off’. Now make sure the volume slider 
above the ‘Change with Buttons’ setting 
is set high enough to wake you up in the 
morning.

2/ Controlling Background App Refresh 
— Background App Refresh is a feature 
introduced with iOS 7 that let third-party 
apps go out and pull new messages, 
headlines, status updates, and more 
from the Internet, even while they’re 
not actively running on your screen. 
Apps busily refreshing themselves can 

put a dent in the battery 
life of your iPhone or 
iPad, particularly if 
you’re not keeping an 
eye on which apps are 
doing the refreshing. 
Facebook and Twitter, 
for example, can silently 
fetch status updates in the 
background; Gmail can 
grab new messages, CNN and New York 
Times will pull the latest headlines, and 
Pocket saves articles you’ve bookmarked 
on the web, all whether they’re active 
on your handset’s screen or not. You can 
see which apps are using this feature 
under Settings>General>Background 
App Refresh. If you see any apps that you 
don’t want refreshing themselves in the 
background, flip the appropriate switch to 
the “off” position. News apps, for example 
(NZ Herald, Guardian, Independent etc) 
may as well only refresh when you open 
them – why have them chugging away 
loading headlines you may not necessarily 
read as you have no time? They will refresh 
when you load the apps up anyway.
Tap Settings>General> Background App 
Refresh, then scroll down the list of apps. 
If you see anything that you don’t want 
refreshing itself in the background, or even 
apps you’ve forgotten you even installed, 

go ahead and flip the 
appropriate switch to 
‘off’.

3/ See which 
background-refreshing 
apps are drawing 
the most battery 
power — Apps that 
refresh themselves 

in the background can put a strain on 
your iPhone’s or iPad’s battery. Tap 
Settings>Battery, then scroll down to the 
Battery Usage section. Tap the Last 24 
Hours tab for a snapshot of your recent 
battery usage, or Last 7 Days for a longer-
term look at your device’s battery use.
Tap the little clock icon next to the two 
tabs for details on how long your various 
iOS features and apps have been whirring 
away in the background.
Don’t forget to tap 
the little clock icon 
next to the two tabs 
(shown left) for details 
on how long your 
various iOS features 
and apps have been on 
the screen — and more 
interestingly, how long 
your apps have been 
whirring away in the 
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tips&tricks iOS continued: setting your iPhone up to use less power

background. If you see any apps spending 
a surprising amount of time running in 
the background, consider cutting off their 
privileges on the Background Refresh 
settings screen.

4/ Turn off background activity for 
all your third-party iPhone and iPad 
apps — If you’d rather not worry about 
whether your iOS apps are playing fast 
and loose with the background-refresh 
feature, you can always shut off the ability 
altogether. Just flip the switch to shut off 
iOS’s Background App Refresh feature 
altogether.
Tap Settings>General>Background 
App Refresh, then switch the main 
“Background App Refresh” to the “Off” 
position. If you’ve already customised 
which apps can refresh themselves and 
which can’t, don’t worry: toggling the 
top Background App Refresh switch does 
not erase your previous settings. Note 
that turning off iOS’s background-refresh 
feature won’t keep iOS’s core apps — 
namely, Apple Mail — from checking for 
updates in the background. For that, you’ll 
need to enable another setting…

5/ Keep Mail from checking for messages 
in the background — Even though it 
doesn’t appear in the background-refresh 

list, the iOS 
Mail app 
burns up a 
fair amount 
of power and 
data as it 
periodically 
checks for 
messages. 
But there are 
a couple of 
ways to curb 
or halt Mail’s 
background 
activity — a 
temporary way 
and a more permanent one.
The latest version of iOS adds an aptly 
named feature that puts your iPhone or 
iPad in a low-power mode when your 
device’s battery meter dips into the red. 
Low Power Mode will temporarily stop the 
Mail app from checking for new messages. 
With Low Power Mode switched on, your 
iOS device turns off many of its visual bells 
and whistles; for example, home-screen 
icons no longer seem to float above your 
wallpaper, and your screen will dim more 
quickly than it usually does.
Low Power Mode will also temporarily 
stop the Mail app from checking for new 
messages. You’ll still be able to check 

for new mail manually, but Mail won’t 
automatically check your accounts.
To turn on Low Power Mode (which must 
be done manually), open Settings and 
choose Battery from the main list, then 
flip on Low Power Mode switch.
To permanently change how often Mail 
checks for messages, tap Settings>Mail, 
Contacts, Calendars Fetch New Data, 
scroll down to the Fetch section, then pick 
an option. 
The less often Mail checks for new 
messages, the more battery power you’ll 
save. Turning off Push data for Mail 
makes a 
difference, 
too, but 
your email 
messages 
won’t 
arrive 
constantly, 
of course.
[I tend to 
use these 
low-power 
and 
occasional 
mail-check 
settings 
only when 
travelling.]

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes


>> >>

Mac NZ

page

12

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2015. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip Enterprises 
2010-2015.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission,   
email 
Mac NZ 

MagBytes
#73

tips&tricks Safari on Mac ~ turn your tabs on 

1/ Tabbed Browsing in Safari — You 
haven’t lived if you’re not using Tabbed 
Browsing in Safari, which lets you boot 
links from search pages into tabs (shown 
above) along the top that you can then 
inspect at your leisure – way more efficient 
than going backwards and forwards trying 
to find the correct link from a search page 
full of links.
Assuming you are using tabs, here are 
some navigation tips: the pre-El Capitan 
option to use Command-1 through 
Command-9 for favourited bookmarks 
remains; after El Cap it has shifted to 
Command-Option plus a number to go 
beyond the first 9 tabs; the Command key 
by itself plus a number moves among only 
the first nine open tabs.

2/ Jump a tab — You can use Control-Tab 
or Command-Shift-] to move from left to 
right among open tabs, one at a time, and 
Control-Shift-Tab or Command-Shift-[ to 
move from right to left. 
This includes pinned tabs (which sit at 
extreme left) which is a new feature 
introduced in El Capitan.

3/ Show All Tabs — Press Command-
Shift-\ to review all open tabs  (or click 
the button that’s by default in the upper 
right corner of the Safari window), which 
are grouped by sites for adjacent tabs 
that have the same domain (like docs.
google.com). Press the keystroke, click the 
button, or press Escape to exit the Show 
All Tabs view. Show All Tabs can be slightly 
more useful, too, if you enable Safari in 
the iCloud system preference pane and 
Settings>iCloud on two or more of your 
devices logged into the same iCloud 
account. Then, Show All Tabs will reveal 
all tabs open not just on your Mac, but 
also on other devices down at the bottom 
of the scrolling window. This isn’t part of 
Handoff, but a separate feature, and useful 
in a different fashion. (These tab tips came 
from Macworld.)

4/ Fixing double initial letters — DO 
you do THis inadvertently while typing? 
I do. To automatically make the second 
letter into a lowercase letter, Microsoft 
Office has a setting, but OS X offers this 
ability  system-wide as part of automatic 

spelling correction. This works in all 
of Apple’s programs and is available in 
other apps that take advantage of it. This 
autocorrect will drop in what OS X thinks 
is the ‘correct’ replacement as you type 
— it may sometimes be the wrong one if 
you’re using a specialised term or a special 
spelling, but generally, it’s the right choice.
In System Preferences, you can enable 
auto-correction in the Keyboard pane 
under Text. 
Tick the ‘Correct Spelling Automatically’ 
box. In individual apps, like TextEdit, 
Pages, or Mail, you can use the Edit > 
Spelling & Grammar sub-menu to make 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.macworld.com/article/3022414/internet/how-to-navigate-among-tabs-in-safari-for-el-capitan.html
http://www.macworld.com/article/3022414/internet/how-to-navigate-among-tabs-in-safari-for-el-capitan.html


>> >>

Mac NZ

page

13

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2015. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip Enterprises 
2010-2015.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission,   
email 
Mac NZ 

MagBytes
#73

tips&tricks iOS continued, and back to the Mac for Safari

sure both Check Spelling While Typing 
and Correct Spelling Automatically have 
checkmarks. 
Many third-party apps have the same 
settings, picked up from the system.

5/ OS X 10.11.4 Beta lets you protect your 
Notes with a Password — One of the 
features in the beta of 10.11.4 is the ability 
to password-protect items in Apple’s 

Notes program – in other words, this will 
come to the public release of OS 10.11.4 
once it’s available. In the Notes app for the 
Beta, there’s now an option to do so under 
the File menu. 
Select a note and click on that, and 
you’ll be asked to set a password and 
(optionally) add a hint.
There are a couple of important caveats 
here. The first is that any password-
protected notes won’t show up on devices 
that don’t meet the requirements. 
So don’t add a password to a note you 
desperately need to sync to your iOS 9.2 
iPhone as it will vanish from that device. 
Also, the password you’re setting isn’t just 
for the one item you had selected, but 
applies to all of the notes you password-
protect from then on. 
The next time you try to apply a password 
to a particular note, you may be asked 
to enter the master one you set. And of 
course, you’ll need to put in that password 
whenever you want to actually read those 

notes in the future. 
So don’t forget it! 
A couple more 
tricks: if you need 
to take off the 
protection for a 
particular note, 
that option’s under 

the File menu; it’ll be labelled ‘Remove 
Password’. Also, under the Notes menu, 
you’ll find some useful choices like Set 
Shared Password. There you can change 
the password you set, or you can reset it 
(which means that notes going forward 
will have a new password without 
changing the one you 
applied to previous 
notes). You could also 
use the “Notes” menu 
to lock the already 
protected items.

You can see details about your Mac at any time by choosing 
About This Mac. It’s the topmost item in the Apple menu – 
under this initial setting (above, called ‘Overview’) you can 

see exactly which version of OS 10 you are running, your 
CPU (processor) speed, how much RAM you have under 

Memory, you can click Software Update to see if there are 
any pending updates for you, or System Report for a very 

full-featured rundown. Along the top, you can also see a 
graphic rundown of what’s using what space under Storage, 

and details about your display. 
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Commander One dual-pane manager for Mac ~ UAG protectionShiny&New
Commander One dual-pane manager
Eltima Software is a German development company that 
specialised in Windows apps to enable sharing of devices, 

over various types 
of networks. But it 
also has developers 
schooled in Apple’s new 
developer language 
Swift, and that was 
used entirely to code 
Commander One. 

Apart from fast dual-pane navigation, copying, compression 
and more, Commander One offers other powerhouse extras, 
and there are even more in the paid version (US$29.95). Anyone 
looking after several Macs will love the Pro version, whereas the 
free version will suit anyone who just wants a Finder alternative 
that makes some everyday tasks considerably easier. It’s available 
from the company site and also in the Mac App store. Read the 
full review on Mac NZ.  

Urban Armor Gear iPhone faceplate
This is a very thin tempered glass shield – the glass is so thin 
it’s flexible to the point it’s easy to think it’s actually plastic, 
but it’s tough, anti-fingerprint, 3D touch compatible glass 
with a particularly high strength. The package comes with a 
little cleaning cloth (clean the glass screen of your iPhone very 
thoroughly before applying it) but once on, you’ll hardly know it’s 
there. More on Mac NZ.
Available from selected NZ outlets and Urban 
Armor Gear online. RRP$39.95-$59.95 
depending on size/model.

Apologies
I will be away next month attending 
to family matters overseas and it will 
simply not be possible for me to create a MagBytes with 
the limited resources and rare internet connections that 
will be available to me during my travels.
I will make up for this with a bigger, extra, bumper, super 
issue for April.
Likewise, my Mac NZ posts will be sporadic at best from 
8th March to 5th April. I am sorry about this; I have 
often managed to keep things going when I’m away and 
over holiday periods but this particular trip makes that 
impossible.
I will still be available by email on mac.nz@mac.com and 
should be able to field enquiries, although perhaps not at 
the usual speed of response I can achieve from NZ.

Urban Armor Gear iPhone 6/6s case
Also from UAG, this slip-on iPhone case is military drop-tested 
to the 810G-516.6 standard. It’s light, doesn’t interfere with the 
iPhone camera’s flash, has buttons that connect to the iPhone 
buttons and a raised lip to stop the screen contacting the 
surface you place the iPhone face-down on. Anti-skid bumpers 
add to the package so it doesn’t slide 
across your desk. RRP$59.
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